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Downloading Exercise Files 
Exercise files can be downloaded from the Cheryl Price web site as follows: 
 

  

 

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 
Click in the Product Search box and type the number of this 
unit standard, as shown at the right. 

4 Click on     

5 Click on   

6 

Under the Exercise Files heading click on the underlined blue hyperlink, ie     

Book Exercise Files – V8 Publisher 2010  Free Download 
The File Download dialog box will display.   

7 If you have Winzip use the following instructions otherwise move to step 8. 

 a   Click on  .    

 
b   Click on the  of the  button. 

 c  If My Documents folder is not displayed click on Set default unzip folder at the 
bottom of the list.  Ensure My Documents is selected then click on Select Folder. 

 d   Click on the  of the  button and click on the My Documents folder.   
The files will be unzipped. 

8 Click on and ensure My Documents folder is displayed.   

Click on  

9 
Click on Open Folder which will display My Documents folder.  Right click on the 
zipped exercise file and select Extract All. Click on Extract.  A folder will be created 
containing the exercise files.   

US 2788 

US 2788 
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Changing Defaults 
Default settings may have already been changed in your Publisher 2010 program.  You can check 
these and change them if necessary as follows.  (You may wish to do this after you have become 
familiar with Publisher.) 

Font and Font Size 
You can check if the font and font size have been changed by looking at the Font box on the 
Home tab.  If it shows  then it has not been altered.  Change the default font to 
Arial 12 pt (or another font, eg Times New Roman 12 pt) as follows: 

1 In a new publication click on the Insert tab and then on .  Draw a text box in your 
publication. 

2 On the Home tab click on  

3 Scroll down the list of styles until you see Normal.  Right-click 
and select Modify as shown at the right.  

The Modify Style dialog box will be displayed as shown below. 

 

4 Click on  and select Arial 12 pt (or font of your choice).  Click on 
OK. 

5 Click on .  Change the Before 
paragraph: option to 0 pt and Between lines: to 1sp as 
shown at the right.  Click on OK. 

The defaults have now been changed for all text boxes in your current publication.   

To change the default for all publications you need to save the publication as the Normal 
template.  To do this click on the File tab and select Save As.  You need to type the 
pathname of the location of your Publisher templates which usually default to 
C:\Users\User Name\AppData\Roaming\Microsoft\Office\normal.pub then click on the 
Save button.   
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Unit Standard 2788 (Version 8) 
 

Title Produce desktop published documents to meet a set brief 

Level 2 Credits 5 

 

Purpose People credited with this unit standard are able to meet the 
requirements of a set brief by planning, producing, evaluating 
and printing a desktop published document. 

 

Classification Computing > Generic Computing 

 

Available grade Achieved 

 
Explanatory notes 
 
1 Candidates must produce three desktop published documents, one from each of 

the following: multi-page, single page, and folded for example – small magazine, 
children’s book, brochures, Curriculum Vitae. 

 
2 Images must retain original integrity (ie they should not be distorted and should 

be at the appropriate resolution for the intended output).  In meeting the brief's 
specifications, text and graphics used must be appropriate for and relevant to 
the purpose of the document. 

 
3 Range 
 Principles of page layout include but are not limited to – composition of elements 

upon the page, text hierarchy, consistent typography, balance, harmony, 
proportion, sequence, contrast, repetition, alignment and proximity.  These 
considerations must be applied consistently throughout the documents. 

 
4 A brief is defined as a clear description of both the desirable outcomes sought 

and the constraints to be met by the solution.  It contains requirements against 
which the success or otherwise of the desktop published document can be 
evaluated.  The brief must be supplied either as part of the candidate’s 
employment (in the case of workplace assessment) or in response to a set task.  
Text, graphics, and specified page layout will be provided for the task. 

 
5 A plan outlines how the requirements of the brief will be realised.  For this unit 

standard, the plan may be informal, and it may be more appropriate to produce 
evidence of it during task completion rather than prior to starting the task or 
project.  Evidence of planning may be oral, written, and/or graphic.   
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6 Definitions 
 Organisational requirements mean the documented policies and procedures or 

commonly accepted practices of a workplace, school or training provider.  The 
candidate must be given access to these prior to being assessed against this 
unit standard. 

 Presentation means the documents produced must show consistent application 
of the principles of page layout, which may include but are not limited to – 
composition of elements upon the page, text hierarchy, consistent typography, 
balance, harmony, proportion, sequence, contrast repetition, alignment, and 
proximity. 

 
7 Legislation relevant to this unit standard includes but is not limited to the: 
 Health and Safety in Employment Act 1992; 
 Copyright Act 1994;  

Copyright (New Technologies) Amendment Act 2008; 
 and any subsequent amendments. 
 
8 An assessment resource to support computing unit standards (levels 1 to 4) can 

be found on the NZQA website at www.nzqa.govt.nz/asm.  
‘The Computing Process - a clarification document’ along with a number of 
specific resources for assessing against unit standard 2788 are available on the 
NZQA website including a resource with ideas for assessing, a combined brief 
and task, a simple plan, and a clarification of this standard. 

 
 
Outcomes and evidence requirements 
 
Outcome 1 
 
Plan simple desktop published documents from a set brief. 
 
Evidence requirements 
 
1.1 The plan identifies the purpose of each document, its intended audience, 

and its specifications. 
 
1.2 The plan identifies the graphics and text to be used in each document. 
 
1.3 The plan identifies the placement of graphics and text for each document. 
 
Outcome 2 
 
Produce the documents. 
 
Evidence requirements 
 
2.1 The text is placed in the documents and re-formatted to meet the 

specifications outlined in the plan. 
 
2.2 Graphics are placed in documents to meet the specifications outlined in the 

plan. 
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2.3 The documents demonstrate consistent application of the principles of 
page layout. 

 
2.4 The documents are saved according to organisational requirements. 
 

Range may include but is not limited to – file type, file name, location. 
 
Outcome 3 
 
Evaluate and print the documents. 
 
Evidence requirements 
 
3.1 The documents are evaluated to ensure they communicate effectively in 

terms of their readability, legibility, presentation, and accuracy. 
 
3.2 The documents are modified if required and compliance with the brief is 

confirmed. 
 
3.3 Sources of text and graphic images used are referenced in accordance 

with copyright requirements. 
 
3.4 The documents are successfully printed to meet the requirements of the 

brief. 
 

Planned review date 31 December 2016 

 
Status information and last date for assessment for superseded versions 
Process Version Date Last Date for Assessment 
Registration 1 30 September 1994 31 December 2013 
Review 2 24 September 1997 31 December 2013 
Revision 3 28 July 1998 31 December 2013 
Review 4 30 July 2002 31 December 2013 
Revision 5 16 July 2004 31 December 2013 
Review 6 22 May 2009 31 December 2013 
Revision 7 18 February 2011 31 December 2015 
Rollover and 
Revision 8 19 September 2013 N/A 

 
Consent and Moderation Requirements (CMR) reference 0226 
 
This CMR can be accessed at http://www.nzqa.govt.nz/framework/search/index.do. 
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Files used in this book 
 
(Instructions are at the front of this book for downloading retrievable files from our web site.) 

 
 

Files to be used 

Buying a Used Car Omaha Beach Golf Club-page 4 

Cards Omaha Golf Course-1 

Charm logo Omaha Golf Course-2 

Cook Omaha Map 

DTP Evaluation Other Effects 

DTP Plan Pacific Reef 

Festivals Text Painters 

Food Pyramid 

Four Seas Rent-a-car logo 

Fruit Rent-a-car text 

ITALY1 Spa.bmp 

ITALY2 Spa 

Jamaica Sun 

Motorhomes1 Swan Lake 

Omaha Beach TCM 

Omaha Beach Golf Club Logo Type 

Omaha Beach Golf Club-page 2 VEGE1 
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Theory 

 
 
 
Learning Outcomes 
 
In this section you will learn -  
 
 
 Desktop publishing information 

 Basic design concepts 

 To identify elements of a publication 

 Desktop publishing terms 
 
 

Section 
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© Cherylprice.co.nz Limited SECTION 1   3 

Desktop Publishing Information 
Desktop publishing software enables the production of documents, 
magazines, newspaper pages, etc to be achieved using a computer 
and a high quality printer, eg laser printer.  Various kinds of 
graphics can be printed on the same page and lines, boxes, shading 
and colour can be incorporated. 

The printed output can be distributed as it is, photocopied or scanned, or it can be used as camera-
ready copy for an offset printer. 

The concept of producing a document using desktop publishing software is entirely different from 
that used in word processing programs.  Desktop publishing techniques require the layout of a 
page to be planned in advance, to allocate areas for pictures, graphic displays, etc.  Text and/or 
graphics can be imported from other programs. 

Equipment required: 

Computer with a hard disk and desktop publishing software. 

Mouse - Use a mouse for drawing boxes, lines, moving graphics and text around the page.  When 
using menus, a combination of shortcut keys and mouse can be used. 

Printer - A good quality printer is essential, usually a laser or ink-jet. 

Optional - Scanner for photographs, drawings, etc from other documents to be incorporated.  
Digital camera. 

 

 
Desktop publishing programs currently in use include: 

• Microsoft Publisher 2010 
• Microsoft Office Publisher 2007  
• PageMaker 7.0  
• Corel Ventura 10 
• QuarkXpress 6 

Sa
m

pl
e D

oc
um

en
t



4   SECTION 1 © Cherylprice.co.nz Limited 

Scanner 

 

Desktop Publishing Tools 
A desktop publisher uses specific tools to produce a publication - computer, monitor, keyboard, 
mouse, printer, scanner and sometimes a digital camera. 
 
The basic set up for desktop publishing is shown below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Computer 
A computer used for desktop publishing needs to be powerful, as many publications will require 
additional memory.  Complex graphics and lengthy publications use a large portion of the 
resources of a computer.  A PC computer with at least 1 GB (Gigabyte) of RAM (Random Access 
Memory) and a large hard disk drive is required to store desktop publishing programs, together 
with graphics and publications.  A USB drive or CD ROM/Writable drive can be used to store 
additional graphics and publications as required. 
 

Large Monitor 
A large monitor can display an entire page of a publication without the user having to zoom in to 
view text/objects.  This prevents headaches and eyestrain. 

Large 
Monitor 

Printer 

Computer 
(which is often 
on the floor) 

Digital 
Camera 
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Printer 
A high quality printer is necessary to print the final copy of a publication 
unless you are sending the file to a print service bureau.  Your printer will 
need to have sufficient memory to interpret the publication/graphic.   

The print speed can vary and is measured in PPM (Pages Per Minute).  
However the speed of the printer is not as important as quality and memory 
capability. DeskJet and Laser printers (sometimes with colour facilities) 
produce a high quality of print and are commonly used by desktop publishers. 

The print quality will vary from printer brand to printer brand.  DPI stands for Dots Per Inch - the 
higher the number of dpi the finer the printer - 600 dpi is finer than 300 dpi.   
 

Scanner and Digital Camera 
A scanner can take a copy of an image and place a copy of that image into your 
computer. It can be edited and adjusted as required, then positioned in a 
publication.  The scanner shown at the right is called a “flat bed scanner” as it sits  
on a desk.  You can also purchase scanners that can be held in the palm of your 
hand - called “hand held scanners”.  These are not so easy to use and do not tend to 
produce good scanned images. 

A digital camera allows you to take photos and then transfer the photos into your computer.   
The photos can be edited and adjusted as required, then used in a publication. 
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Basic Design Concepts 
Graphic design gives you great challenges and opportunities, mainly because 
there are no universal rules for graphic design.  However there are guidelines 
that can be adapted to most situations which provide a framework for your 
design approach, ensuring that the publication receives the kind of attention it 
needs to transmit its message effectively. 

A Visual Glossary is included on pages 12 and 13.  Some of the design concepts explained on the 
next few pages are shown in these illustrations. 
 

Experimentation 
Be willing to experiment 

Design excellence is often the result of trial and error and professional graphic designers rarely 
solve design problems on their first attempt.  Often they spend a considerable amount of time 
sketching out solutions that might work. 

Desktop publishing software programs permit you to follow this same procedure - you can save 
your attempts with different file names until you arrive at the ideal layout.  (It is however, 
preferable to initially use hand sketches.) 
 

Appropriateness 
Be flexible in applying the rules that follow 

Success in graphic communications is based on appropriately relating the elements of graphic 
design to their surroundings.  Appropriateness is based on proportion.  The size of any graphic 
element should be based on the size of the page, the graphic elements that surround it, and the 
emphasis you want it to receive. 

Appropriateness also relates to the content of the publication and the people who will be reading it 
- an advertisement for a clothing sale would have a totally different appearance than a company 
report. 
 

Consistency 
Be consistent 

Be consistent in the layout of various elements of graphic design; also in each page, and across a 
publication, eg same margins throughout the publication; same size heading font sizes.  
Inconsistency can lead to confusion which will weaken a publication. 
 

Balance 
Avoid static balance 

Balance can lead to boredom and interrupted eye movement.  Unequal 
left/right or top/bottom balance helps provide movement and create 
interest to the reader. 
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Establish a Format 
Planning 
Start by creating a plan 

Before creating a publication on screen you need to sketch out a plan based on a brief that has been 
given to you.  You’ll be taken through the planning process in Section 2 of this book. 
 

Grid 
Creating a grid 

A grid is an essential part of layout and graphic design.  A grid consists of a series of nonprinting 
horizontal and vertical lines which define the placement of the graphic elements that make up a 
printed page.  Grids enable you to provide consistency in a publication. 
 

Margins 
Standardise Margins 

Ensure that copy, headlines, chapter titles and page numbers are the same distance from the top, 
bottom, and sides of a page throughout a publication.  A deep top margin can make it easy to 
locate and read these options.  Wide inside margins are good if you are printing on both sides of 
each page. 
 

Borders 
Use borders for visual identity 

Lines and borders can strengthen the visual identity of a publication. 
 

Columns 
Organise body text into columns 

Choose column widths appropriate to the size of type used.  Columns do not 
have to be the same width.  Always use hyphenation if you use justified 
columns and increase/reduce word spacing to create lines of equal length.  
Unjustified columns create a more informal, easy-to-read publication. 
 

Rules 
Use horizontal or vertical lines (called rules) 

Rules can be thick or thin, depending on how they relate to the copy and white space on each page.  
Use vertical rules between columns; use horizontal rules to separate topics in a column. 
 

Headers and Footers 
Used to keep the reader informed 

Headers and footers are information about a publication that are usually located in the top or 
bottom margin of each page (sometimes called “running heads”).  Page numbers can be included. 
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Typography 
Use type to create a personality for your publication 

Type adds personality and expressiveness to a publication. 

Some typefaces are formal: The Grand Hotel  

and others are informal; Mr and Mrs R J Brown cordially invite 

some are interesting; Mid-winter Christmas Dinner 

some are serious. This is a good reading font. 

There are two categories of type - serif and sans serif. 

Serif type has “curly’ parts at the top and bottom of characters:  This is serif type 

Sans serif type is plain and ideal for headlines and subheadings:  This is sans serif type 

Do not mix too many typefaces on a page or in a publication.  Be consistent with the typefaces 
used for headlines, subheadings, body text and captions. 
 

Mastheads 
A masthead identifies the publication and gives it stability from issue to issue, for example, a 
monthly newsletter.  Often a logo is included. 
 

Headlines 
Use strong, descriptive headlines 

Design a headline so it will inform the reader of the focus of the page.  Headlines should be large 
enough for easy reading and can be centred, left aligned, or right aligned. 
 

Subheadings 
Subheads are a transition from headline to body text 

Subheadings lead readers from the headline into the body text and make it easy for readers to 
locate information.  Subheadings are usually in bold. 
 

Captions 
Use captions in small type to describe photos, artwork, illustrations, etc. 
 

Colour 
Use colour to reflect the message you are communicating and to gain impact.  
Bright colours indicate excitement; subdued colours add dignity.  Colour loses impact 
when it is overused. 
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Sample of Available Typefaces 
Samples of fonts that may be available on your computer are displayed below.  Fonts can be 
selected from the Font group on the Home tab or from the Font dialog box.  Shortcut keys can be 
used to change the font and font size.  Ensure that the fonts used are easy to read  (readability).   
 

Typeface Sample 

Arial Black 
This is Arial black 14 pt font 

Copperplate  
Gothic Bold 

This is Copperplate Gothic Bold 14 pt font 

Copperplate Gothic 
Light 

This is Copperplate Gothic Light 14 pt font 

Curlz MT This is Curlz MT 14 pt font 

Eras Bold ITC This is Eras Bold ITC Bold 14 pt font 

Eras Demi ITC This is Eras Demi ITC 14 pt font 

Felix Titling This is Felix Titling 14 pt font 

Forte This is Forte 14 pt font 

Franklin Gothic Demi This is Franklin Gothic Demi 14 pt font 

Franklin Gothic 
Demi Condensed 

This is Franklin Gothic Demi Condensed 14 pt font 

Franklin Gothic Heavy This is Franklin Gothic Heavy 14 pt font 

French Script This is French Script 14 pt font 

Haettenschweiler This is Haettenschweiler 14 pt font 

Impact This is Impact 14 pt font 

Imprint MT Shadow This is Imprint MT Shadow 14 pt font 

Palace Script MT This is Palace Script MT 14 pt font 

Perpetua Titling MT This is Perpetua Titling MT 14 pt font 

Rockwell This is Rockwell 14 pt font 

Rockwell Condensed This is Rockwell Condensed 14 pt font 

Wingdings 

 

Sa
m

pl
e D

oc
um

en
t



10   SECTION 1 © Cherylprice.co.nz Limited 

 

Add Emphasis Where Needed 
When changing type size, style, or using enhancements consider the importance of readability 
(easy to read and follow) and legibility (font size and type is appropriate and easy to follow).  
 
Type Size 
Use large type to emphasise important ideas 

Type size should reflect the importance of the various parts of a publication.  Headlines should be 
larger than subheads and subheads should be larger than body text.  Body text should be larger 
than captions. 
 

Type Style 
Vary type styles to emphasise important ideas 

Add emphasis to important ideas by setting headlines, subheads, and body text in variations of the 
typefaces usually used, eg if the body text is in Times New Roman font, use Arial font for 
headings.  Avoid the over-use of full capitals. 

 Use bold for emphasis 

 Use italics to add emphasis in a less authoritative way 

 Use bold-italics to give a sense of action. 
 

White Space 
Use white space to make design elements stand out 

Use white space for easy reading.  Avoid white space in the middle of a page but use it extensively 
to space out the publication, in the margin areas, and to surround headings. 
 

Reverses 
Use reverse type to emphasise elements of the page 

Use reverse type (white letters on black background) 
to add emphasis to headlines and short blocks of copy. 

Avoid the use of small type; it is preferable to use a sans serif font, bold. 
 

Shading and Boxes 
Use boxes and shades of grey to attract attention 

Shading can be used to add interest to pages without photographs or illustrations - you can use 
dark type against light shading, or reverse type.  Plain boxes can also draw attention to elements 
for text and/or photographs and illustrations. 
 

Artwork and Pull-Quotes 
Photographs, illustrations, charts and graphs can be added to communicate important ideas.  Pull-
quotes are short quotations taken from publication text used to summarise surrounding material 
and draw attention to it.  They can be in large type with lines, or boxed. 

This is Reverse Type 
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Add the Finishing Touches 
Proofreading 
Check for text and layout errors 

Information entered into the document needs to be checked for accuracy.   
Use the spell check facility if available.  Get someone else to review it.  As 
well as proofreading text, check for graphic consistency - ensure that line 
elements are even, headings are in the correct font size, etc. 
 

Leading 
Adjust line spacing 

Adjust the vertical line spacing where necessary. 
 

Widows and Orphans 
Avoid short lines of type at the tops or bottoms of columns 

Ensure that a “widow” (a single word or short line of copy) does not occur at the bottom of a 
column (or page), and that an “orphan” is not carried to the top of a column or page to end a 
paragraph. 
 

Kerning 
Adjust letter spacing with kerning 

Use kerning to improve the appearance and readability of headlines by increasing or decreasing 
letter spacing. 
 

Hyphenation 
Adjust word spacing with hyphens 

Use the hyphenation facility to correct unnaturally large spaces that occur with, or at the ends of 
lines - especially in narrow columns. 
 

Punctuation 
Well-designed publications use curved open and close quotation marks and apostrophes, such as 
“widows” and “orphans”.  Published documents usually use a single long stroke, called an em dash 
to indicate a dash.  There is usually only one space left after a full stop. 
 
 
 If you are intending to do desktop publishing work it is strongly recommended that you read 

books on layout and display, and observe layout.  Such books can be purchased, or borrowed 
from a library. 
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Visual Glossary 

REMBRANDT TO 
RENOIR
Over 300 years of European Masterpieces from The Fine Arts 
Museums of San Francisco.

The Rembrandt to Renoir Exhibition is a breathtaking selection of 

sixty-six masterpieces from one of the richest European art 
collections in the United States.  Spanning three centures, from 1600 
to French Impressionism, Rembrandt to Renoir includes examples if 
Italian, Spanish, Dutch, Flemish, French and British painting.  
Highlights of the exhibition include El Greco's John the Baptist; 
Rembrandt van Rijn's outstanding portrait of Joris de Caulerij; 
Elisabeth Louse Vigee Le Brun's beguiling portrait of Hyacinthe 
Gabrielle Roland; and a fine Monet from the artist's popular Water 
Lilies series.

Continued on Page 2

GALLERY  NEWS
Gisborne City Art Gallery - Quarterly News

1      Gallery News

The Earth Today

EXHIBITION DETAILS

HOURS
Saturday-Wednesday 10 am - 4.50 pm

Late Nights
Thursday and Friday 10 am - 8.50 pm

Late admission and ticket sales 50 minutes before 
Gallery closing.  Please allow for queuing time.  Taking 
photographs is not permitted in the exhibition.

ADMISSION

Adults  $10.00
Senior Citizens, Beneficiaries, Students  $7.50
Friends of the Gallery, Children  $5.00
Family (2 adults and up to three children)  $25.00
Adult multi-visit pass (5 visits)  $40.00

Europe

 

Tag Line  
A second smaller 
heading 

Body Text 
The main text 

Continuation 
Notice 
A line indicating 
where the rest of 
the story can be 
found 

Initial Cap 
A large initial 
character used to 
enhance the 
paragraph 

 Masthead - the title of the newspaper. 

Caption  
Text describing 
the picture 

Bleed Art  
Picture that 
runs off the 
edge of the 
page 

Footer 
A line of text that appears at the 
bottom of each page 

Border  
A line that 
appears 
around text, 
graphics and 
other objects 

Callout  
Descriptive text 
connected  
by a line to an 
object 
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